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Section 1, Starting DASH 
The Discrimination and Sexual Harassment (DASH) database is a tool for personnel in the Department of the Navy 
who manage information about alleged incidents involving sexual harassment and discrimination. 

DASH allows you to input and track allegations about Marines who are either the offenders or the recipients of such 
actions. This manual explains how to use DASH. The procedures for reporting offenses are in MCO P5354.1 and are 
authorized by Title 5 and US Code 301. 

To start DASH, do the following: 

• Enter the Uniform Resource Locator (URL) for Dash into the address line in Microsoft Internet Explorer. 
Internet Explorer displays the Security Alert dialog box, as in the following figure. 

• Click Yes. 

 
 

 

  
NOTE: DASH Reports are Personal and Confidential. Distribution outside of 
the DASH system is not authorized. 
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Another browser window opens, welcoming you to DASH, as in the following figure: 

 
• Enter your user name and password into the appropriate boxes. Contact MPE if you do not know your user 

name and password. 
• Click on Remember My Password if you want to store your password on this computer. 

If you click on Remember My Password, the computer stores the password in your user account and 
automatically fills in the password blank when you log on with this user name in the future. 

• Click OK 
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If your logon is successful, Internet Explorer displays a link to launch DASH: 

 
Do not close this browser window. 

• Click on “Open the Registry.” 

Your logon can be unsuccessful for two reasons: 

• An HTTP error in the 400 series most often means that you typed in the wrong URL. If you selected DASH 
from your favorites menu, it could be that the favorite is incorrect. You can also get this error if the server is not 
available, or if your Internet service is down. 

• An HTTP error in the 500 series means that there was an internal error in the server. This sort of problem is 
usually temporary. If it persists, notify the system administrator. 
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When DASH starts up, it appears as follows: 

 

 The new incident icon allows you to create a new incident. See Section 2, “Adding an Incident,” on page 9. 

 The Find Incident icon allows you to search for an existing incident. See Section 3, “Finding and Updating an 
Incident or Client,” on page 23. 

 The Find Client icon allows you to search for a client. See Section 3, “Finding and Updating an Incident or 
Client,” on page 23. 

 The Change Password icon allows you to change your password. See Section 4, “Changing Your Password,” 
on page 28 

You can double-click on DASH under the Central Registry in the middle pane to display information.  

Your user profile contains the RUC/MCC that you belong to. Therefore, DASH only displays the information that is 
appropriate to your RUC/MCC. 
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The File Menu 

 
The File menu gives you three options: 

• You can copy the data that you are viewing.  

When you click on Copy, DASH makes a copy of the information in the right pane and puts it on the Windows 
clipboard. You can start or switch to a text-editing program, such as Notepad or a word processor, and paste the 
information into the document. 

• You can export the data that you are viewing. When you select Export, DASH displays the File Download 
dialog box 

 If you opened this dialog box by mistake, click Cancel to close it without exporting the data into Excel. 
 Click Open to display the Excel file in Internet Explorer. 
 Click Save to save the file. The Windows Save As dialog box allows you to choose a folder and save the 

file. 
 Click More Info if you need more information about downloading files. 

• You can log off and exit DASH, which ends your session.  



Section 1, Starting DASH The View Menu 

Discrimination and Sexual Harassment Database: User’s Manual Page 6 
Draft, 8 March 2004 

The View Menu 

 
The view menu gives you a number of options that control the way that DASH looks. Some of these options are 
already in effect. Since these settings only affect you, you can change them in any way that suits you. The options 
are as follows:  

Toolbar 

DASH displays the tool bar by default. The tool bar appears directly below the menu bar. You can toggle it on 
or off, as you like. 

Navbar 

The Navigation Bar is the left pane of the main part of DASH. By default, DASH displays the Navigation Bar. 
You can hide or bring back the Navigation Bar by selecting this option. You may want to hide the Navigation 
Bar if you need more room to see the data you are working on. 

Folderbar 

The Folder Bar is the center pain in the main part of DASH. By default, DASH displays the Folder Bar. You 
can hide or bring back the Folder Bar by selecting this option. You may want to hide the Folder Bar if you need 
more room to see the data you are working on. 

Statusbar 

If you select this option, you can display or hide the status bar at the bottom of the window. You may want to 
hide the status bar if you need more room to view data. 
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The Help Menu 

 
The Help menu creates an email message to the DASH administrator. The address is filled in, but the message area 
is blank. Explain the nature of your problem and send the email. 
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The Tool Bar 
The DASH tool bar appears directly below the menu, as shown in the following figure: 

 
The tool bar has four buttons that allow you to perform four common tasks very quickly: 

 The Copy button allows you to copy the data.  
When you click on Copy, DASH makes a copy of the information in the right pane and puts it on the Windows 
clipboard. You can start or switch to a text-editing program, such as Notepad or a word processor, and paste 
the information into the document. 

 The Excel button allows you to export the selected data into a Microsoft Excel spreadsheet.  
When you click on Excel, DASH exports the information in the right pane to an Excel spreadsheet. If the right 
pane is blank, the Excel spreadsheet contains nothing. 
When you select Excel, DASH displays the File Download dialog box, as in the following figure. The dialog 
box contains a warning that does not apply to you in this situation. 

 
 If you opened this dialog box by mistake, click Cancel to close it without exporting the data into Excel. 
 Click Open to display the Excel file in Internet Explorer. 
 Click Save to save the file. The Windows Save As dialog box allows you to choose a folder and save the 

file. 
 Click More Info if you need more information about downloading files. 

 The Show Filter button restores the display of the search filter.  
This button only works if you have completed a search during your current DASH session. 
When you search for something in the unit hierarchy, DASH hides the filter so that you have a clear view of the 
results set. If you would like to see the filter again, click Show Filter. 

 The Hide Filter button hides the filter.  

If you used the Show Filter button to display the filter, you can hide it by clicking Hide Filter.
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Section 2, Adding an Incident 
To add an incident, you can click on the Add Incident icon in the left pane, or you can use the folders in the middle 
pane. To use the folders in the middle pane, do the following: 

• Click on the  icons to open the folders in the folder bar until you see Add an Incident. 
The following figure shows the folder bar completely open: 

 

• Click on Add an Incident  to add a new incident. 



Section 2, Adding an Incident Entering the Alleged Offender’s Social Security Number 

Discrimination and Sexual Harassment Database: User’s Manual Page 10 
Draft, 8 March 2004 

Entering the Alleged Offender’s Social Security Number 
When you add a new incident, DASH begins by prompting you for the alleged offender’s social security number, as 
in the following figure: 

 
• Click on Cancel if you do not want to enter a new incident and got here by mistake. 
• Click on OK to continue entering the new incident. 

What if you don’t know the offender’s Social Security number? 
If you do not know the offender’s Social Security number, do the following: 

• If the offender is an individual: 
Enter 111111111 to signify the offender SSN is unknown 

• If the offender is an organization (such as the entire command): 
Enter 555555555 to signify there are multiple offenders 
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Entering Administrative Information about the Incident 
After you enter the alleged offender’s social security number, DASH displays a dialog box so that you can enter 
administrative information about the incident, as in the following figure. 

DASH assigns a number to the incident, as follows: 

00 + the three-digit MCC + the four-digit year + a four-digit sequence number 

For example, the incident in the below figure would be MCC 009’s fortieth incident during 2004. 

• Fill in the fields with the appropriate information about the incident. 
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The fields are as follows: 

 Report Date The actual date on which the report was sent to the EOA 

 Reporting Service The military service that is reporting the incident 

 Date Initiated The date on which you initially enter the incident into DASH 

 Reported Through: Choose the means by which the information became known from the drop-down box. 

 Other This field is only active if you chose “Other” in the Reported Through drop-down box. If the 
field is active, enter the source of the information here.  

 Sensitivity Select yes or no. If the incident is sensitive, select the reason why it is sensitive from the drop-
down box. 

 POC DASH automatically fills in the name of the point of contact. 

 POC Phone  DASH automatically fills in the phone number of the point of contact. 

 POC Location  DASH automatically fills in the location of the point of contact. 

 MCC  DASH automatically fills in MCC of the point of contact. 

 From Enter the date on which the incident began. See “Entering Dates into DASH” on page 13. 

 To Enter the date on which the incident ended. 

 Location Select the location of the incident from the drop-down box. 

 Other This field is only active if you selected “other” as the location. If it is active, enter the location 
here. 

Type of Discrimination Check the boxes that indicate the types of discrimination that are alleged. It is possible to check 
more than one box.  

 Other This field is only active if you selected “other” as the discrimination type. If it is active, enter 
the type of discrimination here. 
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Entering Dates into DASH 
If you enter a date in a format that DASH does not recognize, the date field turns orange. DASH recognizes dates in 
two formats: 

If you enter a date with numbers: 

• You must use slashes to separate the numbers. 
• You must enter the date as month, day, year in 

that order. 
• You may enter either a one-digit or two-digit 

month or day. 
• You may enter either a two-digit or four-digit 

year. 

If you enter a date with the month spelled out: 

• You must use a four-digit year. 
• You can place the month, day, and year in any order. 
• You can separate the month, day, and year with 

spaces or hyphens. 
• You can enter either a one-digit or two-digit day. 
• You can enter the full name of the month or you can 

abbreviate it. 
Your abbreviation must be at least two letters long. If 
your abbreviation is ambiguous (“oc” is October, but 
is “ma” March or May?), DASH may not interpret 
you correctly. 

DASH interprets all of these dates the same and 
displays the results as 03-Jun-1951: 

DASH interprets all of these dates the same and displays 
the results as 06-June-1951: 

6/3/51 
6/03/51 
06/3/51 
06/03/51 
6/3/1951 
6/03/1951 
06/3/1951 
06/03/1951 
 

6 June 1951 
06 June 1951 
6 1951 June 
06 1951 June 
1951 June 6 
1951 June 06 
1951 6 June 
1951 06 June 
June 6 1951 
June 06 1951 
June 1951 6 
June 1951 06 

6-June-1951 
06-June-1951 
6-1951-June 
06-1951-June 
1951-June-6 
1951-June-06 
1951-6-June 
1951-06-June 
June-6-1951 
June-06-1951 
June-1951-6 
June-1951-06 

6-June-1951 
06-June-1951 
6 1951-June 
06 1951-June 
1951 June-6 
1951 June-06 
1951 6-June 
1951 06-June 
June 6-1951 
June 06-1951 
June 1951-6 
June 1951-06 

6-June 1951 
06-June 1951 
6-1951 June 
06-1951 June 
1951-June 6 
1951-June 06 
1951-6 June 
1951-06 June 
June-6 1951 
June-06 1951 
June-1951 6 
June-1951 06 

 In these examples, DASH would also interpret Jun as June. 

Using the Dialog Boxes 
Four buttons always appear at the bottom of the dialog box. They have the following functions:  

Undo All discards all the changes without closing the dialog box. Use this button if you made mistakes and 
you want to start over. 

Cancel discards all the changes and closes the dialog box. Use this button if you decide not to enter an 
incident. 

Apply saves the information without closing the dialog box. Use this button if you want to continue 
entering information using the icons in the left pane. 

OK saves the information and closes the dialog box. Use this button if you want to save the 
information and you are finished for now 
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Entering Information about the Recipients 
You can click on the icons in the left pane in any order. 

• Click on the Recipients icon to enter information about the recipient. 
DASH displays the dialog box in the following figure: 

• Enter the recipient’s Social Security number in the SSN field 
• Click Search. 

DASH fills in the form with whatever information is available from MCTFS. 

To add an additional recipient: 

• Click on  (the add icon) next to the word “recipients” in the right pane. 

To delete a recipient: 

• Click on the recipient in the list 
• Click on  (the delete icon) next to the word “recipients” in the right pane 
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• Fill in any of the General Information fields that DASH did not automatically fill in: 

 SSN Enter the recipient’s Social Security Number 

 First Name Enter the recipient’s first name 

 Middle Name Enter the recipient’s middle name 

 Last Name Enter the recipient’s last name 

 Date of Birth Enter the recipient’s date of birth. See “Entering Dates into DASH” on page 13. 

 Gender Select whether the recipient is male or female from the drop-down box. 

 Marital Status Select the recipient’s marital status from the drop-down box. 

 Race Select the recipient’s race from the drop-down box. 

 Address Enter the recipient’s street address or unit mail address  

 City Enter the recipient’s city. 

 State Enter the recipient’s state from the drop-down box. 

 Zip Enter the recipient’s nine-digit zip code. 

 Phone Enter the recipient’s telephone number. 

 DSN Enter the recipient’s DSN number. 

• Fill in any of the Personnel Information that DASH did not automatically fill in: 
 Select whether the recipient was a uniformed service member, a federal civil servant, a civilian, or a family 

member. 
 If you select Uniformed Service Member: 
• Select the service component: either regular or reserve. 
• Use the drop-down box to specify the service. 
• Click on Uniformed Service Member to enter the required military data. 

• If you select family member: 
 Click on family member to add additional required data. 

• Fill in the information about substance abuse: 
 Indicate whether alcohol was a suspected factor: yes, no, or unknown. 

• Select the pay plan if DASH did not already select it. If you select Wage Grade, select the pay plan grade from 
the drop-down box. 
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Entering Information about the Alleged Offenders 
You can click on the icons in the left pane in any order. 

• Click on the Offenders icon to enter information about the alleged offenders. 
Notice that DASH’s dialog boxes call alleged offenders ‘offenders.’ In fact, everything in DASH is an 
allegation until the final disposition finds otherwise. 
DASH displays the dialog box in the following figure: 

• Enter the offender’s Social Security number in the SSN field 
• Click Search. 

DASH fills in the form with whatever information is available from MCTFS. 

To add an additional offender: 

• Click on  (the add icon) next to the word “offenders” in the right pane. 

To delete an offender: 

• Click on the offender in the list 
• Click on  (the delete icon) next to the word “offenders” in the right pane. 
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• Fill in any of the General Information fields that DASH did not automatically fill in: 

 SSN Enter the offender’s Social Security Number 

 First Name Enter the offender’s first name 

 Middle Name Enter the offender’s middle name 

 Last Name Enter the offender’s last name 

 Date of Birth Enter the offender’s date of birth. See “Entering Dates into DASH” on page 13. 

 Gender Select whether the offender is male or female from the drop-down box. 

 Marital Status Select the offender’s marital status from the drop-down box. 

 Race Select the offender’s race from the drop-down box. 

 Address Enter the offender’s street address or unit mail address  

 City Enter the offender’s city. 

 State Enter the offender’s state from the drop-down box. 

 Zip Enter the offender’s nine-digit zip code. 

 Phone Enter the offender’s telephone number. 

 DSN Enter the offender’s DSN number. 

 Known Offender Select yes or no from the drop-down box to indicate whether this is a known offender. 

 Relationship to Recipient Select the offender’s relationship to the recipient from the drop-down box 

 Other If the offender’s relationship to the recipient to the recipient was “other,” this field is 
available. Enter the relationship here. 

• Fill in any of the Personnel Information that DASH did not automatically fill in: 
 Select whether the offender was a uniformed service member, a federal civil servant, a civilian, or a family 

member. 
 If you select Uniformed Service Member: 
• Select the service component: either regular or reserve. 
• Use the drop-down box to specify the service. 
• Click on Uniformed Service Member to enter the required military data. 

• If you select family member: 
 Click on family member to add additional required data. 

• Fill in the information about substance abuse: 
 Indicate whether alcohol was a suspected factor: yes, no, or unknown. 

• Select the pay plan if DASH did not already select it. If you select Wage Grade, select the pay plan grade from 
the drop-down box. 
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Entering Information about the Witnesses 
You can click on the icons in the left pane in any order. 

• Click on the Witnesses icon to enter information about the witnesses. 
DASH displays the dialog box in the following figure: 

• Enter the witness’s Social Security number in the SSN field 
• Click Search. 

DASH fills in the form with whatever information is available from MCTFS. 

To add an additional witness: 

• Click on  (the add icon) next to the word “witnesses” in the right pane. 

To delete a witness: 

• Click on the witness in the list 
• Click on  (the delete icon) next to the word “witnesses” in the right pane. 

 



Section 2, Adding an Incident Entering Information about the Witnesses 

Discrimination and Sexual Harassment Database: User’s Manual Page 19 
Draft, 8 March 2004 

• Fill in any of the General Information fields that DASH did not automatically fill in: 

 SSN Enter the witness’s Social Security Number 

 First Name Enter the witness’s first name 

 Middle Name Enter the witness’s middle name 

 Last Name Enter the witness’s last name 

 Date of Birth Enter the witness’s date of birth. See “Entering Dates into DASH” on page 13. 

 Gender Select whether the witness is male or female from the drop-down box. 

 Marital Status Select the witness’s marital status from the drop-down box. 

 Race Select the witness’s race from the drop-down box. 

 Address Enter the witness’s street address or unit mail address  

 City Enter the witness’s city. 

 State Enter the witness’s state from the drop-down box. 

 Zip Enter the witness’s nine-digit zip code. 

 Phone Enter the witness’s telephone number. 

 DSN Enter the witness’s DSN number. 

 Requests Anonymity Select yes or no from the drop-down box to indicate whether the witness wishes to be 
anonymous. 

 Relationship to Recipient Select the witness’s relationship to the recipient from the drop-down box 

 Other If the witness’s relationship to the recipient to the recipient was “other,” this field is available. 
Enter the relationship here. 

• Fill in any of the Personnel Information that DASH did not automatically fill in: 
 Select whether the wintness was a uniformed service member, a federal civil servant, a civilian, or a 

dependent. 
 If you select Uniformed Service Member: 
• Select the service component: either regular or reserve. 
• Use the drop-down box to specify the service. 
• Click on Uniformed Service Member to enter the required military data. 

• Fill in the field labeled Witness Summary. Enter narrative text that summarizes the witness’s account of events. 
• Select the pay plan if DASH did not already select it. If you select Wage Grade, select the pay plan grade from 

the drop-down box. 
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Entering Information about the Disposition of the Incident 
You can click on the icons in the left pane in any order. 

• Click on the Disposition icon to enter information about the disposition of the incident. DASH does not accept a 
date in the Date Action Complete box unless you enter a closure code in the Closure Code drop-down box. 
DASH displays the dialog box in the following figure: 
The dialog box contains drop-down boxes for some of the data. Not all of them are appropriate for all stages of 
processing. The figure shows the Closure Code drop-down box. 
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Fill in the applicable fields for the disposition as follows: 

General Information 
• Enter the date on which the action was complete. See Entering Dates into DASH, on page 13. 
• Select substantiated or unsubstantiated from the Closure Code drop-down box. You cannot do this unless the 

Date Action Complete field is filled in. 
• Select the trial results from the Trial Results drop-down box. 

Convening Authority Approval 
• If the convening authority has given approval, check the Has Approval box. 
• If the Has Approval Box is checked, the Approval Results field is available. Enter narrative text to describe the 

approval results. 

Action Taken 
• From the Administrative drop-down box, select whether the administrative action was administrative 

separation, nonjudicial punishment, personnel action, or no action. 
• If there is a value in the Administrative drop-down box, the corresponding Action Taken field is available. 

Enter narrative text to describe the actions that were taken, or the reason why no action was taken. 
• From the Judicial drop-down box, select whether it was a civilian trial or a general court martial. 
• If there is a value in the Judicial drop-down box, the corresponding Action Taken field is available. Enter 

narrative text to describe the actions that were taken. 

Results of Court-Ordered Conviction 
• From the Military drop-down box, select whether the court ordered imprisonment, a discharge, a fine, a 

reduction in grade, or other. 
• If you select “other” from the Military drop-down box, the corresponding Other field is available. Enter in a 

description of the military court action. 
• If there is a value in the Military drop-down box, the Military Sentence field is available. Enter narrative text to 

describe the sentence. 
• From the Civilian drop-down box, select whether the court ordered confinement, a fine, mandatory counseling, 

or other. 
• If you select “other” from the Civilian drop-down box, the corresponding Other field is available. Enter in a 

description of the civilian court action. 
• If there is a value in the Civilian drop-down box, the Civilian Sentence field is available. Enter narrative text to 

describe the sentence. 
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Submitting the Incident for Processing 
After you have entered all the information about the incident, you can submit it for processing. 

• Click on the Processing icon in the left pane. 
DASH displays an explanation of the process. DASH displays an explanation of the file status codes, which you 
can also find in the Appendix. 

• Click on the Submit button to submit the incident for the next processing step. 
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Section 3, Finding and Updating an Incident or Client  
If you need to add information to an existing incident, you must find it first. There are two ways to find an incident: 

• You can use an existing query. 
• You can create a new query from scratch. 

Using an Existing Query 
You can find incidents by using a saved query, which is what DASH calls a set of search criteria that has been saved 
so that it can be reused. 

• Click on the  next to Incidents, if necessary, to display the items below it. 
 Click on the  next to My Queries to display the items below it. 
 Click on the  next to Shared Queries to display the items below it. 

 
• Click on a query to use it. 

DASH displays the results in the right pane. 

• Click on the new incident icon  to add a new incident. 

• Click on the magnifying glass icon to create a new query. 
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Creating a New Query 
It may be that none of the existing queries are suitable for you. In that case, you can create one. 

• Click on the Find Incident in the left pane or in the folder structure in the middle pane. 
DASH displays the Find Lead view on the right side, which allows you to create a basic query. The following 
figure shows the beginning of a query for incidents that occurred between 31 December 2001 and 5 January 
2002, inclusive. 
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• Fill as many (or as few) blanks as you like with the pertinent information. 
• If you want to see only the incidents that match all the criteria you have entered, click on And. 

For instance, if you enter Sexual as the discrimination type, Illinois as the location, and click on And, DASH 
displays the incidents about sexual discrimination in Illinois. 

• If you want to see incidents that match any of the criteria have entered, click on Or. 
For instance, if you enter Sexual as the discrimination type, Illinois as the location, and click on Or, DASH 
displays all of the incidents that involved sexual discrimination, no matter where they occurred, and all 
incidents that occurred in Illinois, no matter what type of incident they were. 

• To apply the query, click Apply & Close. DASH displays the matching incidents. 
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Creating an Advanced Query 
Sometimes a basic query turns up too many incidents and you need to fine tune it. You can change your basic query 
into an advanced query at any time by clicking on the Advanced button, as in the following figure. Notice that 
DASH carries over all the work you did in the basic query. 

• Use the drop down boxes to add more criteria, operators, and values. 
• To apply the query, click Apply & Close. DASH displays the matching incidents. 

 



Section 3, Finding and Updating an Incident or Client Saving Queries 

Discrimination and Sexual Harassment Database: User’s Manual Page 27 
Draft, 8 March 2004 

Saving Queries 
You may only need to use a query once, but if it is particularly useful, you may wish to save it for future use. 

• Click the Save icon . DASH prompts you to give the query a name: 

 
• Enter a name for the query. 
• Check the Share this Filter box if you wish to share the query with others. 
• Click OK. 

The query appears under My Queries in the folder structure in the middle pane, or under Shared Queries if you 
chose to share it. 
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Section 4, Changing Your Password 
It is a good idea to change your passwords from time to time to keep them secure. To change your password for 
DASH, do the following: 

• Click on Change Password in the middle pane. 

 
DASH displays the Change Password dialog box. 

 
• After you enter old password, your new password, and confirm the new password, click on OK. DASH changes 

your password. 
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Appendix: File Status Codes 
DASH uses the following file status codes: 

Draft (D) 
A draft incident report is work in progress. The information is not yet complete. 
DASH users have full control over draft incident reports. 

Pending Initial (PI) 
A pending initial incident report contains all required information. The DASH user has submitted it for initial 
approval, but USMC Headquarters has not yet accepted it. 
DASH users can move an incident report from pending initial status back to draft status if it is necessary to 
change any of the information. 

Initial (I) 
Initial status means that the incident report has been submitted to USMC Headquarters. 

Pending Final (PF) 

Pending final status means that the incident report contains all required information and is awaiting final 
approval by USMC Headquarters. 
DASH users can move an incident report from pending final status back to initial status if it is necessary to 
update any of the information. 

Final (F) 

Final status means that USMC Headquarters has approved the incident report. 
DASH users cannot make any changes to incident reports in final status. 
DASH administrators can move a final incident report back to pending final status if any changes are required. 
If USMC Headquarters has already accepted the incident, the DASH administrator must contact Headquarters 
USMC and ask them to change the status. 
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